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1 Welcome

Thank you for using CardExchange® PriceTag for producing your food labels! 

CardExchange® PriceTag offers a multiple template interface that allows you to produce

food labels in just a couple of clicks. The entire main interface is designed to enhance ease-

of-use and improved intuitiveness.

CardExchange® PriceTag is food label solution offering, that comes with an internal

database which enables better protection and management of your stored data. 

It's not just about software, it's about the experience!
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2 FAQ

This page contains a selection of our most common and frequently asked questions...

· How can I activate a CardExchange® PriceTag license?

· How can I move my CardExchange® PriceTag installation to another computer?

· How can I create a new card with the user-guided wizard?

· How can I create a new card without the user-guided wizard?

· How can I connect to an Excel database?

· How can I show a variable image on the card layout?

· How can I print multiple records on a single card?

· How can I protect CardExchange® PriceTag with user names and passwords?

· Using GDI+ printing technology when printing results are poor.
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3 Getting Started

In this help file we will cover the installation and setup, as well as explain all available

functionality of CardExchange® PriceTag.

3.1 Requirements

Before you start installing CardExchange® PriceTag on your system, please make sure to

take notice of the requirements as mentioned below to ensure a successful installation,

activation, and registration of CardExchange® PriceTag on your system:

· You can install CardExchange® PriceTag on Windows 7,  Windows 8, Windows 8.1,

and Windows 10,

· You should have the Microsoft .net framework version 4.8 or higher installed,

· We support 32 and 64 bits operating systems,

· We advise to use Intel i3 or higher processors, but at a minimum it should be a dual

core processor,

· When using 32 bits OS we advise a minimum of 2048 MB internal memory but we

advise 4096 MB, especially when using 64 bit OS,

· We need 400 MB of Hard disk space,

· and an internet connection to activate and register your license.
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3.2 Installation

CardExchange® PriceTag users a standard InstallShield Wizard, during the installation the

installer will start checking the system requirements. The important thing that will be

checked by the installer is that the .NET Framework 4.6 is installed. When not available, the

installer will automatically start downloading this. If there is no internet connection

available, it will automatically install it from DVD. If you are using the downloaded trial

version and during the installation no internet connection is available, the installer will stop

the installation process and you will be required to install the application manually.

The .NET Framework is normally available on the computer system, so we will not go

deeper into this. 

When you first run the installation wizard, you will be prompted to choose your language:

The CardExchange® PriceTag installation wizard then starts with the welcome page, now

click Next to proceed:
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In this wizard page, the License Agreement is presented. You can click on the Print button to

print out the complete text of the agreement. If you agree to the terms, please select the "I

accept the terms in the license agreement" option and proceed with Next. If you do not

agree, please select the " I do not accept the terms in the license agreement" and click on

Finish. The installation will be canceled:



CardExchange® PriceTag Help10

© 2020 CardExchange Solutions, Inc.

In the Customer Information page you can provide specific information like the user name

and the organization. More important is to determine who is allowed to use this

application. Here you can select the option "Anyone who uses this computer (all users)"

which is default and we advice to use for standard installations. Especially important when

multiple users have access and accounts on the target computer. Select "Only for me (user

name)" if you want to make sure only this user has access to the application. Click Next to

proceed:
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CardExchange® PriceTag installations are compliant with Windows standards which means

that by default the application is installed in the Program Files (x86) folder as shown in the

screen shot below. The folder will be automatically created during the installation. Click on

the Change button if you want to install CardExchange® PriceTag to a different location.

Click Next to proceed:
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The Database folder of CardExchange® PriceTag is one of the most powerful and flexible

features of the CardExchange® PriceTag application. It contains all your card templates,

database, saved documents, etc. It is very important to install this database folder on a

location that can be accessed by the user or by more users of the computer. The

CardExchange® PriceTag application reads and writes information from and to this folder

and therefore the user needs to have read and write permissions to this location. By default

it will be installed under the Public Documents folder, like as shown in the screenshot

below. If you install this Data folder on a location that is not available for all users of the

system, it will result in error messages and not being able to start up!

Make sure that you make regular backups of this Data folder. In case of a computer crash,

this backup will save you a lot of work. You only have to install CardExchange® PriceTag as

normal and after the installation you replace the new Data folder with the backup and your

system is up and running again! We advice to make a backup of the Data folder, every time

you change something to your configuration. Click Next to proceed with the installation:
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Now the installer has all the information to start installing CardExchange® PriceTag on

your system. Click Install to proceed:
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When the installation has succeeded, you can click on Finish to close the installer. Any

temporary files will be removed from your system. You can run CardExchange® PriceTag by

double clicking on the Desktop icon or by selecting the application from the Windows Start

menu.

3.3 Our Trial Edition

Our CardExchange® PriceTag trial offers you unlimited access to all available functionality

for a period of 30 days after installation. When you have installed CardExchange® PriceTag

for the first time, just check the Evaluate box for CardExchange® PriceTag.
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When you have checked the evaluate option, simply click on OK to start your trial and use

all functionality offered. The only limitation of the trial is that it prints a DEMO watermark

on the card. The nice part is, when you have configured, designed, connect to databases,

etc., and you like our CardExchange® PriceTag application, you simply purchase a license,

activate it, and you keep on working. Nothing needs to be redone!

Activating your trial or your new installation is explained in our Activation and Registration

section of this Help file.

3.4 Activation and Registration

When you have used our trial edition and you want to use it, or you directly purchased

CardExchange® PriceTag, you will have to activate the application. 

To activate CardExchange® PriceTag you need to have a Serial Number and Activation

Code.

The serial number is a 6 digit number and looks like 123456. The activation code is a 34

digit number and looks like 00000-11111-22222-33333-AAAAA-BBBBB-CCCC.

Activating your license is very easy to do. Just start your new installed CardExchange®

PriceTag application or start your trial edition.
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Select "Activate" from the about window or click on the "Activation window" option under

the Assist tab.
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Enter your serial number and activation code.

The Machine ID is unique for each computer that CardExchange® PriceTag is installed on and is used for activating
the license and identify your computer by our licensing system. The Machine ID is generated based on your internal
computer hardware. If activation fails because you have, for example, no internet connection on your computer, your
license can also be activated directly via our website but to activate your license via our website, you need to have
this unique Machine ID.

When you have entered your license information, you click on Activate to start the

Activation process.

At the moment the activation process starts, you can start registering your license.

Registering your license offers a lot of benefits such as informing you about new releases

and updates, etc. 
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In the registration page you can enter all your company and contact information. The fax

number is optional, all other fields are required. 

IMPORTANT! Your provided information will never be commercially sold and will only be used to provide

you with important information about your software and hardware!

When you have provided all information, click Next to proceed to the next page of the

registration.
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If you would like to be contacted, just select how and when, and your reseller will contact

you on the preferred date selected.

Last but not least, subscribing to our newsletter offers you information specific for your

software and hardware that you are using.

Click Next to proceed to the Final page of the registration process.
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During the registration process, your CardExchange® PriceTag license has been activated.

Click on Finish to finalize the activation and registration and start CardExchange® PriceTag.

For more information about updating your registration, please visit our "Update Your

Registration Info" section of this Help file. 

3.4.1 Data Folder

During the installation of CardExchange® PriceTag you are asked to select a location for

your Data folder. By default this folder is installed in your Public Documents folder under

CardExchange® PriceTag.
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The Data folder of CardExchange® PriceTag is very powerful and unique at the same time.

Everything that you design like templates, database connections, etc., all these files are

stored in the Data folder of CardExchange® PriceTag.

When you open the Data folder you see the sub folders for each region, these contain

specific templates that have the required information and correct currency symbol for each

location.

The SQLite database that contains the data as well as the login information is also located

in this location.
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The sub-folder contains all the configuration from all the different templates. We therefore

strongly advice to make regular backups from this Data folder especially when you have

made changes in your configuration.

When your computer crashes and you need to reinstall CardExchange® PriceTag, after the

installation and re-activation, you copy the backup of the Data folder back, start

CardExchange® PriceTag and all your configurations are restored and you can start

working directly again.

The Data folder can be located on any location, also on a network server. The Data folder

can however not be shared between different CardExchange® PriceTag editions inside your

company. Each CardExchange® PriceTag license needs to have it's own unique Data folder.

3.5 Transfer PriceTag to New PC

If you are looking to transfer your CardExchange® PriceTag installation to a new PC, then

you can follow the below steps:

1. Install CardExchange® PriceTag on the new PC

2. Copy the Data directory from the old PC, by default this is located: C:

\Users\Public\Documents\PriceTag\Data
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3. Delete the Data directory from the same location on the new PC and copy in the

backup from the old PC

4. Run CardExchange® PriceTag and check that everything is ok

5. Enter your original serial number and activation code in the activation wizard to

activate to the new PC

In some cases the data folder may not be in the default location, for example it may be

on a network share so that it is always backed up.

If this is the case you can check the current path being used for the data folder, to do

this you will need to open the CardExchange.ini configuration file from the old PC which

is located in the installation directory.

By default this is C:\Program Files (x86)\CardExchange Solutions\PriceTag\
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If you open the CardExchange.ini file in notepad you will see an entry for DataDirectory

which will show you the current path. If it is a network share then you can simply point

the new installation to the same network share, otherwise you can just copy the folder

and change the path following the same steps above.

Note: This Data folder is automatically backed up when an upgrade is installed, however we recommend

making regular backups of this folder as it contains all of the configuration files/templates/logins etc…

for your installation.
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4 Using the Main Interface

To get started with CardExchange® PriceTag, it is important to get familiarized with the

interface. It is important to know that CardExchange® PriceTag basically is a combination

of two disciplines:

· The Main Interface offering the multiple card-template interface and data-editing,

etc.

· and the Configuration Interface, the Designer.

Most of the time you will be working from the main interface

In a very convenient way it offers you the possibility to select your card-templates at the

left side followed by selecting the record that needs to be printed, you can edit the data if

required and then print from the actions pane on the right side.

The configuration of this all is done directly via the Configuration Interface, the Designer.
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In the same setup as the main interface, from the left side you see available pages with all

the available tools organized in different sections via the ribbon interface.

As we recognize that most people are used to working with Microsoft Office products, our

CardExchange® PriceTag product is also designed accordingly. Not to make our lives

easier, but yours! Everybody that can work with Microsoft PowerPoint or Word, will have no

problems finding their way in CardExchange® PriceTag! 

4.1 Menu

Open the menu by clicking on the Application button on the left upper corner. In this menu

you can select to logout if you are using User Authorizations.



CardExchange® PriceTag Help28

© 2020 CardExchange Solutions, Inc.

You can also click on About CardExchange® PriceTag to show you information like your

serial number and installed version. Last but not least, the Exit button that closes

CardExchange® PriceTag.

4.2 Ribbon Overview

CardExchange® PriceTag offers functionality for printing, producing, and creating cards.

The Main Interface of CardExchange® PriceTag is especially designed to create a very user-

friendly production environment. All the functionality is organized within each separate tab

of the Main Interface ribbon.

TAB DESCRIPTION

Home All functionality related to printing and data editing

Configuration All available configuration functionality

Assist All functionality related to support of CardExchange® PriceTag

4.2.1 Home

The Home tab is organized in different groups with specific functionality.
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Group Function(s) Description

Options Printer

Options

Configure your printer(s)

Standard printerPrint card Opens the print dialog

Printer

properties

Opens the printer properties dialog of the selected printer

Export

preview

Exports a preview of the card as a file

For more detailed information about printing, please visit the "Printing Cards" section of

this Help file...

Find Text box Enter a value to search for in this text box

Find Opens the Find dialog

Find next Finds the next result matching with the value in the Find

dialog

Refresh data Refreshes the data in the product list

Select all Selects all the available records in the product list

Import/Export Import recordsImport records from a csv file

Export recordsExport records to a csv file

Filters Edit

categories

Opens the Edit level two filter dialog to configure the

categories

Categories Shows all the created level two filters (Categories) in a drop

down menu

For more detailed information about using data, please visit the "Using Data" section of

this Help file...

4.2.1.1 Printer Options

When the printer options window is opened, it will present any available printers installed

on the system. 

Just select the printer you want to use from the list view and click on OK to confirm.
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If you want to use the selected printer for all loaded card-templates, make sure you leave

the option checked for "Apply these settings to all loaded cards" otherwise each card-

template will have it's own specific printer connected. 

4.2.2 Configuration

The Configuration tab is organized in different groups with specific functionality.
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Group Function(s) Description

Options Advanced Options Opens the Advanced options window

Loaded

cards

Card manager Opens the Card Manager Window 

New card Select to create a new card-template

Export templates Exports a complete template including database

connections, etc.

Import templates Imports templates including database connections, etc.

Duplicate template Duplicates an existing template

Selected

Card

Card designer Opens the Designer in configuration mode to edit the

template

Database setup Opens the existing Database connection to make

changes 

Authorizatio

ns

Account setup Opens the wizard to create users

Enable logins featureEnables functionality to use log in's

Under the configuration tab it is possible to set the language for CardExchange® PriceTag,

you can also restore views and hide different panes.

Group Function(s) Description

Zoom Zoom in Zoom in the card preview

Zoom out Zoom out the card preview

100% Set the card preview to 100%

Options Language Set the language of the CardExchange® PriceTag

Restore view Restore the default view

When you change the language selected under the configuration tab, the displayed

language of CardExchange® PriceTag will change accordingly.

Also the regional specific data folder will be changed so the available templates will also

change to match the region selected, these contain specific required information and

correct currency symbol for each location.

4.2.2.1 Advanced Options

In the Advanced options window you can set some specific settings for the CardExchange®

PriceTag application:
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Database connections

Quote table and column

names: 

Select if quotes needs to be used (default). Not used with

Cache DB

Designer

Show advanced mappings: Shows the Edit card-definition and Edit mappings button in the

Configuration tab for using old version 6 templates

Maximum resolution (DPI):Set the maximum resolution for images (Default is 600)

Imaging
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OLE-header length: This is the amount of bytes to remove from the OLE header for

MS Access databases. Default 78 is when using an English MS

Access version

Maximum image size: Set the maximum image size for images on the card design

layout

Detail-editor width: Set the default width for the database columns in the

data edit window (Default is 200)

Service center

Show error messages: Check this option to show error messages when content is

not loaded in the service center window

If you want to use these settings for all loaded card-templates, make sure you check "Apply

these settings to all loaded cards"

4.2.2.2 Advanced Mappings

When you have selected to Use Advanced Mappings in the Advanced Options window, in

the Selected Card Group you know see two extra buttons appearing:

Group Function(s) Description

Selected

Card

Card-definition

wizard

Opens the Card-definition wizard to make advanced

changes

Mappings window Opens the Card-definition wizard on the mappings

section 

All features are included in the Card designer, so you are unlikely to need either of these

options.

The exception is that, for advanced users, you can use these options to create cards and

select pre-existing card design or database definition files.

4.2.3 Assist

The Assist tab is organized in different groups with specific functionality.
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Group Function(s) Description

Refresh Refresh Refreshes the available news items

Help Help Opens this online help file

Licensing Activation window Opens the Activation Wizard window

Register license Opens the Registration Wizard Window

About About CardExchange®

PriceTag

Opens the About dialog containing license and

machineID info

PriceCardPr

o

Vendor Opens the CardExchange® PriceTag website

For more detailed information about the Assist options, please visit the "Using Assist"

section of this Help file...

4.3 Display Panes

The CardExchange® PriceTag is split into different panes that can be moved and re-sized

as desired.
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4.3.1 Cards

When the Cards tab is selected, all the available and selected card-

templates are shown. By clicking on the button, the template with all

the settings and configurations will be loaded in the Main interface.

The available card-templates can be divided by groups which can be

selected from the drop down menu directly under the tab.

Card-templates, the availability, the position in the menu, etc., is

defined via the Card manager.

For more information, please see our "Using the Card Manager"

section of this Help file



Using the Main Interface 37

© 2020 CardExchange Solutions, Inc.

4.3.2 Categories

CardExchange® PriceTag offers pre-defined category filters to help find

information in the connected database and make it available for your card

production.

All the defined Category filters are available in the Categories pane and

can simply be selected by the user by clicking on the button.

The filters can also be divided by groups which, if applicable, can be

selected from the drop down menu directly under the Categories tab.

For more information about using and configuring filters, please visit our

"Category Filters" section of this Help file.

4.3.3 Records Pane

In the Records Pane in the main interface of CardExchange® PriceTag you see all the

records presented that are available in your database. When you make a database

connection, in the name list page you select the columns that are shown in the Records

Pane. You can find everything about making database connections in the "Using Databases"

section of this Help file.
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Record Sorting

The Records Pane is a so called data grid showing all your available database records

divided by columns. Sorting the records is just as simple as clicking on the column. 

Record Look Up

It is very simple to search for records inside the Records Pane. Enter the text that you want

to search for in the text box directly above the columns. The text you enter always applies
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to the first column,if you want to look up records from other columns, you have to drag the

column to the front. 

Loaded Record Information

In the footer of the Records Pane the total amount of loaded records is shown.

4.3.4 Data Edit Window

The Database Edit window offers the possibility to manage your connected database data. 

This window can be customized and configured in the database setup wizard with available

columns as well as drop down menu's.

On the left side it offers buttons for adding a New record, Insert the record, Update a

record, Delete a record, and Cancel your entries.

More about the configuration of this window can be found in the "Using Data" section of

this Help file. More information about database configuration, please see the "Using

Databases" section of this Help file.

IMPORTANT! CardExchange® PriceTag does not support deleting for Microsoft Excel files. When using

Microsoft Excel, records can only be inserted and updated.



CardExchange® PriceTag Help40

© 2020 CardExchange Solutions, Inc.

4.3.5 Card Preview

The Card preview shows a preview of how the card will print for the selected database

record. 

The preview can be shown as black text on a white card, or white text on a black card. This

can be changed under the page setup in the designer for each template.
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4.3.6 Actions Pane

In the Actions Pane, located at the right side of the main interface, the

option to directly print the selected record(s) is available.
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5 Using the Designer

CardExchange® PriceTag Designer follows the latest Windows and Office look and feel. For

the setup of the functionality we have chosen to follow the flow of Microsoft PowerPoint

which will make it very easy to find your way inside of CardExchange® PriceTag Designer.

All configuration is done in the Designer, even database connections are made here. Via

easy drag and drop functionality you can add database fields onto the card design as well

as add fixed text and images.

5.1 Menu

In the Main menu of the Designer you can find all common functionality needed to print,

setup, export etc., your card.
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Available functionality

· Save Save the template and/or the modifications you made

· Print This menu has two sub items:

· Quick Print (Send the template directly to the selected

printer without making any changes)

· Print preview (Preview and make changes to pages before

printing)

For more information about printing, please see the "Printing

Cards" section of this Help file.

· Page setup Opens the Page Setup window. More information about Page

Setup can be found in the "Page Setup" section of this Help file

· Export This menu has five sub items and allows you to export the card

layout as an image. You can export different formats like BMP,

JPG, PNG, etc.

· About

CardExchange®

PriceTag

This opens the about window with version information of

CardExchange® PriceTag

· Exit This will quit the Designer or close the Configuration mode 
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5.1.1 Page Setup

To start the Page Setup window, click on the Page Setup button in the Main Menu.

5.1.1.1 Page

For each selected page in your layout, specific settings can be made. For example, if you

are having a double sided print with two pages, the front page can be set to Landscape

and the backside can be set to Portrait.
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Margins

· Enter the page margins

Orientation

· Change the orientation for landscape or portrait

Print options

· Set the print options for the layout;

o Select printable for graphical printing the page

o Select or deselect Backside to print or not print the backside
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5.1.1.2 Template

Every Card (Template) designed with CardExchange® PriceTag can contain multiple pages.

Each Page can have its specific settings but the template itself holds some specific

information like the connected printer being used to print the different pages.

In this section you can define all the specific template settings like selecting the printer

being used, card size, etc...
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Card size

· Printer - Select the printer to be used

· Card size - Select the specific card size

· Width, Height - Enter custom card sizes

Rows and columns

· In this section you can define how many columns and rows need to be printed on

one page. If you set the Number of rows to 3, 3 records will be printed on, for

example, the front page of the card. This technology can be used to print multiple

records for, for example, the use of breakable cards. See more information about

how to use Rows and Columns.

Print options

· Print backside first - Select this option if the backside of the card needs to be

printed first.

· Print last card first - Select this option if you want to print the last card from the

batch first.

· Print using the GDI+ print engine - Select this option to use the GDI+ print engine

(default), unchecking will use the Microsoft XPS print engine. For more information

CLICK HERE.

· Enabled pre-rendering of objects into the background image - For more

information CLICK HERE.

· Send to printer as bitmap - Select this option if you want to have CardExchange®

PriceTag create a bitmap image first and send it to the printer instead of sending

all objects separately.

5.1.1.2.1  Using GDI+ Printing

CardExchange® PriceTag by default, uses a GDI+ print engine, however you can also

disable this option and use a Microsoft  XPS print engine if required.

As CardExchange® PriceTag uses advanced graphical objects that sometimes are not

supported by GDI+, you can use this technology in combination with Pre-rendering of

objects. 
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5.1.1.2.2  Pre-rendering of Objects

This option enables pre-rendering of objects into the background image of the layout

page. When selected, all objects that have been flagged for pre-rendering, together with

the background image or brush of the layout page, will be rendered to a bitmap image

and sent as such to the printer.
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By default, only image objects are flagged for pre-rendering, but on the Visibility tab of the

Properties window, pre-rendering can be enabled or disabled for any individual object.

Pre-rendering is needed when printing via the GDI+ if your design uses graphics that are

not supported by the GDI+.

Pre-rendered objects will always show behind any other objects in the printed result, even if

that is not the case on the preview.
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5.2 Explorer Menu

Just like in the Main Interface,  CardExchange® PriceTag

Designer also contains an Explorer menu. Also here the Explorer

Menu is based on the Explorer Menu as it is available in

Microsoft® PowerPoint.

This Explorer Menu contains three tabs which are described in

sub sections of this Help file.

The Explorer Menu gives an overview of all your created layouts,

pages, connected data, etc.

You always open the actual Template selected in the Main

Interface.
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5.2.1 Pages

When selecting the Pages tab (default) all the available layout

pages are shown.

Simply click on the page or the layout header to select. Specific

settings for the available Layouts can found in the Page Setup

section of this Help file.

How to Pages can be found in this specific section.
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5.2.2 Outline

When the Outline tab is selected you find a quick overview of all

the available objects on the pages, in the Layout.

It is presented as a tree view and by hovering over each

available object, a preview of the object is shown like in the

screen shot, hovering over the image object shows the preview

of the image.
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5.2.3 Data

The Data tab is offering, depending on the configuration:

· Database columns

· Storage items

From here you you can drag database fields onto your card

design and also configure storage items.
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5.2.3.1 Database Columns

When you are connected to a database or MS Excel file, this tab

contains all the available columns of the connected database/file.

Simply select the item and drag and drop it on your card design.

Specific Properties can be set in the Properties window.

How to configure databases is explained in the "Using

Databases" section of this Help file.
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5.2.3.2 Storage Items

If you want to store data into the connected database, you need

to define storage items. Storage items contain the information of

the column name in which you want to save your information like

a print date or counter. These Storage Item mappings are made

via the Content tab in the Properties window.

Please visit the Storage Items section of this Help file for more

information about using Storage Items.

5.3 Ribbon Overview

Following the structure of Microsoft® Office, the Home tab reflects all the most common

functionality that is required.

Clipboard functionality for easy Copy, Cut, and Pasting. In the Font group you can easily set

the font type, size, color, and outline the text. You can outline your text and objects and

borders can be easily set and colors can chosen.

The main objects for inserting are also available from the Home tab in the Insert group. The

Properties window is called from the Home tab too as well as the option to change the

preview to white on black. 
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It is also possible to minimize the ribbon if you need more space on your design because

you are using a smaller screen.

Right mouse click on one of the available tabs to open the context menu and select

Minimize the Ribbon.

Now you only see the headers of the tabs and more space is offered. Clicking on the tab

will have the Ribbon information expand. After selecting the functionality it will close

again.

To restore the Ribbon, simple right mouse click on one of the tabs and deselect Minimize

the Ribbon from the context menu. 

5.3.1 Insert

Just like in the Home tab, objects can be selected and inserted onto the design here. 

Via the Insert tab you can insert the following objects:
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· Text

· Images

· 1D Barcodes

· 2D Barcodes

· Rectangles

· Ellipses

· Lines

5.3.2 Page Layout

The Page Layout tab reflects the first tab (Page) of the Page Setup window.

If you want to add a Background color or Background Image, you can add this via the

Background button. More information about the Page Setup can be found in the "Page

Setup" section from this Help file. More information about how to use Backgrounds, please

refer to our "Using Backgrounds" section of our Help file.

5.3.3 Data

When the Data tab is selected, you find two different groups:

Group Function(s) Description

Connection Edit Opens the Database wizard to edit the existing database

connection

New Opens the Database wizard to create a new database

connection

Select Opens the file dialog window to select an existing database

connection

Remove Disconnects and removes the existing database connection

Record

Navigation

First Navigates to the first available record in the database
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Previous Navigates to the previous database record in the database

Next Navigates to the next record in the database

Last Navigates to the last record in the database

For more information about creating and editing database connections, please see our

"Using Databases" section of this Help file.

5.3.4 View

When the View tab is selected, you find two different groups:

Group Function(s) Description

Zoom Zoom in Zoom in on the current page

Zoom out Zoom out on the current page

100% Zoom to 100%

Fit template Zooms the page that it fits the window

Fit width Zooms the page that the width of the page fits the width of

the window

Fit height Zooms the page that height of the page fits the height of

the window

Options Inches Change the display units to inches

Centimeters Change the display units to centimeters

Pixel Change the display units to pixels

5.3.5 Assist

The Assist tab is organized in different groups with specific functionality.

Group Function(s) Description

Refresh Refresh Refreshes the available news items
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Help Help Opens this online help file

PriceCardPr

o

Opens the PriceCardPro website 

For more detailed information about the the Assist options, please visit the "Using Assist"

section of this Help file...

5.4 Rows and Columns

CardExchange® PriceTag offers the possibility to print multiple records on a your card. This

can be very handy when printing, for example, breakable cards for key chains.

Select the Layout, open the Page Setup window, and select the Template tab. Here you can

find the Rows and Columns section. Enter the amount of columns and rows you want to

use. 
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5.5 Templates

As you have read in the Using the Designer section of this Help

file, all your configuration is done in the Designer. Therefore

the CardExchange® PriceTag Designer works based on

templates.

To understand how CardExchange® PriceTag works, it is

important to take special note of this section of the Help file.

Basically every time you create a new card with

CardExchange® PriceTag you are creating a new Template.

In the Main Interface of CardExchange® PriceTag you always

switch between the different available Templates (see the

"Loaded Cards" section).

With the Designer you always create a new or open the

selected Template. But it is always ONE Template!

Each Template has always one Printer connected, one

Database connection.

Each Layout can have Multiple Pages. You can have a Page for the Front Side and a Page

for the Back Side. Each Page holds all the objects like text, image, Barcode, etc...

5.6 Properties

All objects used with the CardExchange® PriceTag Designer have more properties than

shown in the Add Object window. All these properties are available in the Properties

Windows.
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 Click on the Properties button in the Home tab to open. In the Properties Window you can

find specific properties for:

· Content

· Position

· Text

· Border

· Colors

· Visibility

· Database Columns
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5.6.1 Content

In the content tab you can enter information when you are using a Fixed Value object. This

information will then be presented on the Page design in the Text object. Of course when

connected to a database, this Content tab will show the data from the connected column.

The box around the text area will be GREEN when it contains information coming from a

connected database.
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You can change the information by selecting a different Standard Object Type. More

information can be found in the "Using Images" section of this Help file.

Instead of selecting a Standard Object, the information can also simply be changed by

selecting a database column from the Data Menu in the Explorer Menu and drag and drop

this field directly into the Content text area.
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Formatting Options

The Content tab also offers the possibility to do some advanced formatting. In the

Formatting Options group you can set the Letter case for the content. You have four options

for the Letter case:
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· Maintain Original - No changes to the original

· Lowercase - Makes the content Lowercase

· Uppercase - Makes the content Uppercase

· Namecase - Makes all the first letters Uppercase

You can add a prefix and a suffix to your content and make it always visible. By default it is

unchecked which means that if there is no content available, for example from the

database, the prefix or suffix information will not shown.

You can also set the Format of the content. This can be handy if you want to make sure that

it is always a integer, date, text, etc., content. You can select the following Formats:

· Date/Time

· Decimal

· Floating Point

· Integer

· None

· String

You can also format the content using Numeric format strings. For example in the screen

shot below we have selected Integer as the format and entered 'd4'. That means that the

content will be representing four digits. So if the value from the database is 1, setting it to

d4 will show 0001.
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5.6.2 Position

In the Position tab you can set the specific position, sizes, and margins. Of course this

reflects the position on the Page as you dragged and dropped it so you may not need to

change them. However in some situations you will have to set the positions, sizes, and

margins based on specs provided by the customer. Instead of trying to accomplish this with

a very stable hand, you can here directly enter the values.
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Also the Horizontal and Vertical alignment can be set. Set the preferred stretch setting and,

if applicable, enter the rotation angle in degrees.
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5.6.3 Text

In the Text tab you can set the Font Type and the Font Size in the Font Group.

Besides the alignment options, you can set the Font Stretch. The Font Stretch is not the

same as the text stretch because it determines the intense of the font when stretching while
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the standard stretch just make sure the text fits in the text box. With the Font Stretch you

can choose from:

· Normal (Default)

· Ultra Condensed

· Extra Condensed

· Condensed

· Semi Condensed

· Semi Expand

· Expand

· Extra Expand

· Ultra Expand

In the Text Layout section you can choose from:

· Default

· Word wrap

· Shrink to fit

· Customized text layout

Word wrap will automatically start a new line when the edge of the text box is reached,

shrink to fit will automatically reduce the text size to fit in the text box.

In the Customized text layout you can set the Maximum number of lines for the text object.

That means if you set, for example, the value to 2, it does not matter how large the text

object on the page is, it will only use maximum two lines for the text. If you do not use

stretch functionality, it will not fit the box if it over exceeds 2 lines.

Bringing it to the Stretch option. Stretching and Stretch Direction combines the perfect

functionality to get good results in your text object on the Page. In the Stretch Drop Down

Menu you can select:

· None (default)

· Fill

· Uniform

· Uniform Fill

In the Stretch Direction you can select:

· Up Only

· Down Only

· Both
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Now, for example, when selecting the option Fill in the Stretch Drop Down Menu, in

combination with the Down Only option from the Stretch Direction Menu, the Font will be

re-sized horizontally only.

Text Object without Stretch

Text Object with Stretch set to Fill, Stretch Direction to Down Only

Instead of using Stretch functionality, you can also trim the text. There are basically three

options for text trimming:

Text Object without Text Trimming

Text Object with Character Ellipsis Text Trimming

Text Object with word Ellipsis Text Trimming

The last option in this Text property is setting the Line Height. By default this is not disabled

and it uses the standard line heights for the Font Type. In some situations it can be that the
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standard will eat up to much space you have available on Page Design. When you select

the check box, the text box right next to it becomes available and you can enter a value for

the line height. The value used is depending on the settings you made in the Options

section in the View tab, centimeters, inches, or pixels. See example below:

Text Object without using Line Height

Text Object using 0.10" Line Height

5.6.4 Border

In this section of the Properties Window you can set the properties for the borders of the

objects. 
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In the first group you can define all the values for the Border thickness. For example, when

adding a rectangle object to your Page Design, you can select the border thickness from

the Home menu in the Border section:
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You can also enter this directly in the Border Thickness section of the Border tab. This is

handy if you need to set specific values provided by your customer.

For example, we add an image object on the Page Design and set the values for entering to

pixels in the Options section of the View tab. This object looks like below:

Now we set the Border Thickness to 3 pixels for the Right and Bottom:
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Now the photo object will look as below:
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Now you get totally fancy by combining this with the Corner Radius. For example, we set

the Corner Radius for the Bottom-Right to 10 pixels and see the result below:

This can be done with all existing objects available with CardExchange® PriceTag. It even

can become more advanced if we are combining the objects borders with colors and

backgrounds. More about this in the Colors section of this Help file.

Last but not least, when using Text Objects you can use padding. Padding is the space

inside the object and is therefore not the same as Margin as that is the space outside of the

object.

Text Object without Padding

Text Object with Left and Top Padding

5.6.5 Colors

Depending on the object used on the Page design, different color options are available

divided in three different groups:

· Foreground brush - sets the foreground color of the object

· Background - sets the background color for the object

· Border brush - sets the border color for the object
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Each group offers four different style options:

·  Transparent

·  Solid color

·  Gradient
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·  Image

Colors can be selected directly from the drop down menu as indicated with the red arrow:

Picked from the color selection area as indicated with the blue rectangle:

Created by moving the color sliders to the preferred position as indicated with the orange

rectangle:
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Or directly entered into the text boxes right from the color sliders as indicated with the

purple rectangle:

There are so many possibilities to combine that it is impossible to explain them all. We

have created a couple of examples which are explained in the sub sections of this Color

subject.

5.6.5.1 Text Object Example

For this example we added a text object to the Page design and set the colors as shown

below:
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The foreground color is set to blue and for the background color we used orange with a

gradient style which creates the result below:
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5.6.5.2 Image Object Example

For this Image Object example we added a Image of a photo to the Page design and

created a border via the Border tab. We have set the system to use pixels and we have the

set the properties as following:
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Now the Image object on the Page design looks like below:
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What we will do now is replace the Solid Color Border with an Image that we will load.

In the Border brush group we select the Image style as indicated and we select an image

by clicking on the Select image... button. When the image is loaded, the Page design will

show the following result:
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5.6.6 Visibility

The Visibility tab contains four separate group sections:

· Visibility

· Opacity mask

· Background removal

· Pre-rendering
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Visibility

In the visibility group you can set the opacity of the image on the Page design. This can be

used to create ghosting images. For example, as shown in the screenshot, see the

differences in the images shown below:
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No Opacity Opacity 50%

Besides setting the opacity for the image, you can also select the visibility of the image as

well the printability. Each drop down menu offers three selections:

· Visible

· Hidden

· Collapsed

Opacity Mask

With the Opacity mask you can do some great and advanced stuff. For example, we have

created an opacity mask using the gradient tool and the background color orange.

Now take a look at the photo images below. On the left you have the original and on the

right the photo with the opacity mask.
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No Opacity Using Opacity Mask

But you can also load images or use solid colors.

Background Removal

CardExchange® PriceTag offers advanced background removal. Use the sliders to define

the correct removal. You can also enter the values directly into the text boxes right from

each color slider. For example, we removed the background based on the slider

configuration below.

Now take a look at the photo images below. On the left you have the original and on the

right the photo with the background removed.

No Removal Background Removed
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It is important to realize that the result of the background removal depends on the quality

of the image and the used background. Always try to use real blue or green backgrounds

when taking photos as this offers the best removal result.

Pre-rendering

When using Pre-rendering of background objects, you can check individual objects to set

them to be pre-rendered.

By default certain objects are already checked, but for other objects you can also check

them if required.

5.6.7 Database Columns

When you are connected to a Database, all the available database columns become

available in the Database columns tab of the Properties window.
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 See our Database section of this Help file for more information about connecting to and

using Databases.
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Via the Record navigation section in the Data tab, you can easily navigate between the

different available records and the selected record will be shown in the Database columns

tab.

These database columns can be directly dragged and dropped to the card design via the

Data tab of the Explorer menu as explained in the Using Databases section of this Help file.

5.7 Layouts

As explained in the Templates section of this Help file, Layouts can contain one ore more

Pages. 

Each Page can be set to Portrait or Landscape and of course can have it's own unique

objects.

In this section of the Help file we will explain how to Add pages to your layout and how to

Delete them.
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For your own convenience it is possible and advisable to rename the Layout. When you

right click on the Layout name a context menu will be show and you select Rename. You

can also double click on the Layout name and change it. 

5.7.1 Adding Page(s)

When you have selected your layout, you can add a page by clicking on the Layout Page

button in the Home tab.

You can also add a Page via the Layout page button in the Insert tab.

Click on Layout page to add the page as shown in the screen shot.
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Each page can be setup via the Page Setup window as described in that section of this Help

file.

5.7.2 Delete Page(s)

You can delete a page by selecting it and via the right mouse click content menu, selecting

Delete layout page.
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5.8 Objects

CardExchange® PriceTag offers a lot of objects to design your card. From standard text

objects to shapes to image objects to 1D and 2D Barcodes etc...

Each object comes with a collection of Properties that can used to customize your objects

to your wishes. The properties of the objects are explained in the Properties section of this

Help file.

In this section we will go over each available object and how to use it.

5.8.1 Text

Select the Text object from the Insert tab or from the Insert section of the Home tab. Click

with the mouse on a location of the page and select one the available Standard Object

Types from the drop down menu. Select the font type, size, outlining, etc.
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For more information about the different Standard Objects, please see the "Using Standard

Objects" section of this Help file.

5.8.2 Image(s)

Select the Image object from the Insert tab or from the Insert group at the Home tab and

place this on the page by clicking on a location on the page.
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When the Insert new object window opens, it is default set to Fixed Image.  Variable Image.

You can find more information about these configurations in the specific sections of this

Help file.

When using the Fixed image, you can select an Image by clicking on the Select image...

button. When the image is presented, you can check the 'Point to image file' check box. By

default it is unchecked which means that the image is embedded into the page. If the check

box is checked, a reference to the file is made. The advantage of this is that it keeps your

template small because it does not contain images, the disadvantage is that if the folder

that contains the image is moved or removed, your image will not be shown anymore.

Of course it is also possible to align the image to your needs. You can align the image

horizontal, vertical, and stretch. 

When you hover over the presented image, you will see two buttons appearing with the

options of editing or removing the image.
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Clicking on edit will display the Edit image window as below where you can edit some

basic attributes of the image as well as manually crop it.

IMPORTANT! Every object in CardExchange® PriceTag has many Properties which are not shown in the

Insert new object form. Please see the Properties section of this Help file for more information about

specific use of functionality.
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5.8.2.1 Variable Image(s)

CardExchange® PriceTag offers a unique feature that allows you to switch images based

on a value from the connected database.

The process for adding the Variable Image is exactly the same as explained in the "Using

Images" section of this Help file.

Select Variable image from the object drop down box and the Select database column

drop down box will become available. If you select a field that contains a text or number

value from the connected database, the system will automatically make it a 'Point to image

file' connection. It can also that your database contains the complete reference to image

file locations if that is the case, please leave the Image folder location empty and set the

file extension to 'Extension included in source value'.

The image folder location can be entered directly as it can also be selected by clicking on

the  button. Select the file extension of the image, we currently support bmp, png, gif, tif,

tiff, jpg and jpeg files.

You can also set the format of the value coming from the database you know for sure there

is no mismatch.
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If the database contains the image data and you have selected the image column, the

'Point-to-file options' section will be disabled.

CardExchange® PriceTag contains a large number of images that you can use on your

designs, these include product images as well as those for allergens and other product

marking. 

These can be found in the root of the Data folder, which by default is located here: C:

\Users\Public\Documents\PriceCardPro\Data\Images\

Check for more options like colors, borders, visibility, etc., the Properties section of this

Help file.

5.8.2.2 Backgrounds

There are basically two ways to use backgrounds on your page. You can simply add an

Image object to your Page, select the Image to use, and select Fit to page.

A better way to go is using the Background functionality offered in the Page Layout tab.
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When you click on the Background button, four options are offered.

Use no color or image...

Choose from a one solid color...

Use a Gradient color...

Or use a background image.

The advantage of using a background via the Page Layout tab is that it will always make

sure that it completely covers the whole card, this makes sure that your image is always

fitting the page and you will have no white lines with printing.
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5.8.3 1D Barcode

To add a 1D barcode object to you page, just select the Linear barcode button from the

Insert tab and click on a location on the page to place it. 

You can now select the Symbology that you want to use from the drop down menu. All

most common 1D Barcodes are supported.

By default Fixed value is selected, for using other values please see the "Using Standard

Object Types" section of this help file.

Of course a lot of extra options are available for the 1D Barcodes, but they need to be

accessed via the Properties window of the Designer. When the properties window is

opened, select the Content tab.
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You can add a checksum, set the options for specific Barcodes like Codabar, Code-128, etc.

5.8.4 2D Barcode

To add a 2D Barcode object to you page, just select the 2D barcode button from the Insert

tab and click on a location on the page to place it. 
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You can now select the Symbology that you want to use from the drop down menu. All

most common 2D Barcodes are supported.

By default Fixed value is selected, for using other values please see the "Using Standard

Object Types" section of this help file.

Of course a lot of extra options are available for the 2D Barcodes, but they need to be

accessed via the Properties window of the Designer. When the properties window is

opened, select the Content tab.
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Just like with the 1D Barcodes, a lot of specific 2D Barcode options can be set.

5.8.5 Drawing Objects

Select the Line, Rectangle, or Ellipse button to add it to the page. 
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Check for more options like colors, borders, visibility, etc., the Properties section of this

Help file.

5.8.6 Formating Objects

In the Home tab you can select the font, font size and font color that you want to use for

your object. 
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For more information about formatting of objects, please see our "Properties" section of

this Help file. 

5.8.7 Arranging of Objects

CardExchange® PriceTag offers a lot of functionality to arrange your objects on the page.

All the arranging functionality is available via the Arrange group in the Home tab or via the

Context menu.

You can use the content alignment to position content within the objects own boundaries..
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The Bring forward option allows you to change the z-order of the selected object so that

you can position it over other objects. Bring to front will bring the selected object to the

top layer.

The Send backward option allows you to change the z-order of the selected object so that

you can position it under other objects. Send to back will send the selected object to the

bottom layer.

The Fit to page option will make the selected object fit the entire page.



CardExchange® PriceTag Help106

© 2020 CardExchange Solutions, Inc.

The alignment options allow you to align multiple objects and set the height/width equally

as required. You can select multiple objects by holding down the shift key and clicking on

the required objects.

There are two group options, first you can group objects together so that they can be

moved as one object on the design. Second you can add items to a stack panel which will

stack fields underneath each other. The stack panel can be useful if you need to list

database fields but some of them may be blank, the stack panel will not include the blank

entries and will just stack the fields with content. You can select multiple objects by holding

down the shift key and clicking on the required objects.

Objects can be rotated clockwise/counterclockwise from the rotate menu, you can also click

on the marker above the selected object and drag it to rotate it as well as set a specific

rotation angle under the properties window.
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5.9 Standard Object Types

With exception for the Image object, CardExchange® PriceTag offers Standard Object

Types. Standard Object Types is functionality that can be connected to the object. In this

section we will inform you how to use these Standard Objects Types.

Standards Objects Types can be selected when adding a new object to your Page

designer or via the Content tab in the Properties window.

5.9.1 Concatenation

Concatenation is very powerful functionality offered in CardExchange® PriceTag. It offers

you unlimited ways to present or store data.
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In this example we are adding a new Text object to our Layout and we have it set to the

default Standard Object Type, Fixed Value, and we enter a value into the text area, in this

case "Fixed" Now we click on the Concatenate button under the formatting options.
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Now we get a new option to select a Standard Object Type, in this case, also a Fixed

Value of "With Concatenate" is used but this can be any Standard Object Type available.

Now you see that the Standard Object Type is changed from Fixed Value to

Concatenation as indicated with the red square above.

The Concatenations are divided by expandable tabs. When you click on the left down

arrow  it will open the selected one and close the previous opened:
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You also see a red vertical line on the left. This indicates the group of Concatenations.

There are no limitations to the amount of Concatenations you can make. You can always

change your Concatenations in the Properties window at the Content section.

By default, Concatenations are automatically separated with spaces. You can uncheck this

option if you do not need it and you can also add a Prefix/Suffix when using database

columns as the source for the content. 



Using the Designer 111

© 2020 CardExchange Solutions, Inc.

5.9.2 Fixed Value

Select Fixed Value from the Standard Object Type drop down menu, indicated with the

red rectangle and enter the text into the text area. 
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5.9.3 Global Counter

Select Global Counter from the Standard Object Type drop down menu, indicated with

the red rectangle and set the Global Counter options in the group indicated with the

orange rectangle. When using the Global Counter, you see that the text area is indicated

with a green rectangle. This means that the value shown is generated based on the settings

for the Global Counter and cannot be changed in the text area.



Using the Designer 113

© 2020 CardExchange Solutions, Inc.

5.9.4 Print Date

Select Print Date from the Standard Object Type drop down menu, indicated with the red

rectangle and it will directly present the date. You can also show the date and time or time

only by setting the date format options. When using the Print Date you see that the text

area is indicated with a green rectangle. This means that the value shown cannot be

changed in the text area.

The date reflects the date and time as available on your computer.
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5.9.5 Database Columns

When you are connected to an database, in the Standard Object Type drop down menu all

the database columns are available for selecting.

The Standard Object Type Database columns also indicates the name of the connected

database in the header. In this example it mentions 'Database columns (PriceTagExcel)'.
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When selecting a database column from the list, you will see that the text area is indicated

with a green rectangle. This means that the data shown is coming from the connected

database and cannot be edited in the text area.

See our Database section in this Help file for more information about using databases.
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6 Adding Card Templates

There are two ways in CardExchange® PriceTag to add a new card-template. You can do it

basically from scratch using the Designer or you can use the CardExchange® PriceTag User

Guided Wizard. 

The default option is to use the User Guided Wizard.

When you select the Configuration tab, in the Available cards group you can directly select

New card or you can click on the Card manager.



Adding Card Templates 117

© 2020 CardExchange Solutions, Inc.

And click on Add. For each process it starts in the CardExchange® PriceTag User Guided

Wizard. 

6.1 Create-a-Card Wizard

Using the wizard is in most cases the best way to go. This will give you a complete

designed card-template including database connection, logos, database fields, Barcodes

etc... 

Step 1
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First you need to specify a name for the new template, you also have the option to select

an existing group for the template or to create a new group.

You can also leave the group option blank. When done, click next to proceed.

Step 2

In this page you need to select the card size and the orientation needs to be set, also if you

want to create a single or a double sided card-template. 

When choosing extended card sizes, the option for double sided is disabled as this is not

possible with the Duo or Flex printers. 

You can also choose to have white text showing a black background for the card preview

which is the default option.

When done, click next to proceed.
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Step 3

If you wish to add a logo to the card design, check the box and then browse to the image

file.

A preview of the logo will show on the screen, once happy click next to continue.
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Step 4

On this page all the available columns from the database are made available for you to

select. To add the field to your design, just click on the check box before the column name. 

When all the needed columns are selected, proceed by clicking next.
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Step 5

1D Barcodes and 2D Barcodes are available to add to the card design if required. We offer

a large variety of Barcodes including all the standard symbologies.

The Barcode symblogy can be selected from the drop down menus as well as the database

column that contains the information. Last step to take, click next to proceed.
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Step 6 

CardExchange® PriceTag has now all the information to generate the card-template and as

soon as you click on Finish, the template will be generated. 
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If you have the check box selected, the Designer will open offering you the possibility to

make adjustments to the created design, if not, the card will be directly show in the Main

Interface and the database, if applicable, will be loaded and shown. 



CardExchange® PriceTag Help124

© 2020 CardExchange Solutions, Inc.

More information about editing the design can be found in the "Using the Designer"

section of this Help file.

6.2 The Designer

When you directly want to enter the Designer and create your template from scratch you

have to step through the wizard and then click on Finish.
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The CardExchange® PriceTag Designer will open with a blank template that is connected

to the internal database, you can now design the card as you want.

More information on using the Designer can be found in the "Using the Designer" section

of this Help file.

6.3 Edit Card Definitions

The Card-Definition wizard contains two pages. The first page contains all the information

about the layout and database connections. Both pages are explained in the sections Card

Definition Wizard and Advanced Mappings.

By default the Edit card definition button is hidden and only advanced users should enable

this option. You can enable it by checking the box for "Show advanced mappings" under

the advanced options in the Configuration tab.
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6.3.1 Card Definition Wizard

The card definition wizard is divided in 2 sections:

· Layout 

· Database connections
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Besides of the different sections, the definition wizard also offers functionality to create a

visible note per card definition that will be shown on the main window of CardExchange®

PriceTag. Simply type the information that you want to show to the user, click on Settings to

make some changes to the fonts and colors, and the note will be available for the user.

6.3.1.1 Layout

In this section of the wizard you are defining the card templates. You can create new ones,

edit existing ones, or select card template files. All the basic settings that have to do with

producing a card are available in this section.
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 Because CardExchange® PriceTag is a card production application, a card layout always

needs to be created. Other selections are:

Functionality Description

Do you want to enable

printing?

Select this option if you want to produce cards. 

Print front Default this option is set to the settings of the card layout. If

the card layout is created as double sided, this option will be

checked. Deselect this option if you have a double sided card

layout and you don't want to print the frontside...

Print back Default this option is set to the settings of the card layout. If

the card layout is created as double sided, this option will be

checked. Deselect this option if you have a double sided card

layout and you don't want to print the backside...

Rotate front When selecting this option, CardExchange® PriceTag will

rotate the complete front of the card 180 degrees and send it to

the printer driver.

Rotate back When selecting this option, CardExchange® PriceTag will

rotate the complete back of the card 180 degrees and send it to

the printer driver.

Print backside first When using double sided card layouts, you may want to print

the backside first. Setting this option makes sure that the

backside will be printed first and the front side last...

Send to printer as bitmap Occasionally you may want the complete layout to be

processed and sent to the printer driver as a single Bitmap

image. Selecting this option sends the card layout as an image

to the printer driver...

6.3.1.2 Database Connections

In this section of the wizard you are defining your database definitions. You can create new

ones, edit existing ones, or select database definition files.

Functionality Description

Do you want to connect to a

database?

Select this option if you want to connect to a database and

want to create a database definition... Click on Create to create

a new definition or click on Edit to edit a existing one.
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6.3.2 Advanced Mappings

At the left-hand side you see a navigator object, typically in CardExchange® PriceTag only

storage items that have been left unmapped in the Designer will show here. It is possible to

map a storage item to an environment variable such as the PC or application user name if

using the logins feature.

From the drop down menu, as indicated, you can select different Object Types to map to

the items in the Explorer on the left side. Most of the functionality is already available in the

Designer and these objects are linked to that separate section of the Help file.

These Standard Object Types are:

· Concatenation field

· Database Column

· Environment variable (Not available via Designer)

· Global counter

· Print date
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· Variable image
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7 Managing Card Templates

In CardExchange® PriceTag we offer the possibility to manage unlimited card-templates. A

card-template is a collection of card-layout(s), card-page(s), and/or database connections. 

All card-templates are managed via the Card Manager. 

The Card Manager is called from the Configuration tab of the CardExchange® PriceTag

Main window.



CardExchange® PriceTag Help132

© 2020 CardExchange Solutions, Inc.

In this Card Manager window, all loaded card-templates are presented in a selectable list

on the left side. You can check and uncheck card-templates by clicking on the check boxes

for the card-template names. Unchecking a card-template means that it will not be visible

in the Explorer Menu under the Cards tab.

With the buttons on the right side of the Card Manager window you can perform the

following actions:

Button Description

Move up Moves the selected card up in the Loaded Cards tab

Move down Moves the selected card down in the Loaded Cards tab

Add Add a new card-template and opens the card-template wizard

Edit Opens the card-template in the Designer for editing

Rename Rename the selected card as it appears in the Loaded Cards tab

Remove Remove the card-template

By clicking OK, the window will be closed and all changes will be saved. Hitting Cancel will

cancel all changes made except the ones done via the Edit functionality.

For more information about how to add new card-templates, please see the "Adding Card

Templates" section of this Help file.

7.1 Export Templates

CardExchange® PriceTag has the option to export card templates. This includes the card

design (.cedx) and database definition (.dtd) files..

This can be beneficial from a support perspective but also from a configuration point of

view as designs can be setup prior to an installation.

Clicking on Export template will prompt you to select the desired templates that you wish

to export.
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When you click OK you can specify the location to export them to, as well as the name for

the exported (.ctp) file.

7.2 Import Templates

CardExchange® PriceTag also has the option to import card templates. This includes the

card design (.cedx) and database definition files.
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This can be beneficial from a configuration point of view as designs can be setup prior to

an installation and imported later.

When you click on Import template you just need to browse to an already exported

template (.ctp file) and click on open. 

As exports can contain multiple templates you can then select which templates you wish to

import, by default all templates are selected.

When clicking on OK the template is imported and will appear in the Cards tab of the

explorer view in the main window.
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7.3 Duplicate Templates

CardExchange® PriceTag also offers the possibility to duplicate an existing card template.

This can be useful if you want to have a second card design that has just a few changes

from an existing card design.

First select the card template that you wish to duplicate, then click on the Duplicate

template button.

You will then be prompted to enter a new name for the template, this name has to be

unique.
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Once you click on OK, you will see the duplicated template in the cards tab of the explorer

window.

IMPORTANT! Duplicated templates share the same database definitions as the original template. Any settings

changed will apply to both templates.
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8 Printing Cards

The Home tab has the print options organized in different groups with specific

functionality.

Group Function(s) Description

Options Printer OptionsSelect the printer to be used

Standard

printer

Print card Opens the print dialog

Printer

properties

Opens the printer properties dialog of the selected printer

8.1 Select Standard Printers

When the printer options window is opened, it will present all the installed Printers on the

system CardExchange® PriceTag is running on. Just select the printer you want to use from

the list view and click on OK to confirm.
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If you want to use the selected printer for all loaded card-templates, make sure you check

"Apply these settings to all loaded cards" otherwise each card-template will have it's own

specific printer connected.

8.2 Print Using Standard Printer

There are three ways to print a card to the standard printer.

· Click the Print button in the Standard printer section of the Home tab,

· Select the Print option in the Actions Pane or

· Press Ctrl+P on your keyboard
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If you use the print option in the Actions Pane, CardExchange® PriceTag will start printing

directly, using the default settings. Otherwise, CardExchange® PriceTag displays the

window shown below.

In the Selected printer group you can find the information of the printer you are printing

too like the Name of the printer, the Status of the printer, Type, etc.

Just like in normal Microsoft Office Applications, in the Print range group you can set to

print the Selected record, All records, or a selection of Records. The Number of selected

records is indicated in this named field.

Next to the name, the button Properties... gives access to the printer-properties window,

allowing to adjust any settings before starting to print. Generally, it is not necessary to

change the printer properties once they have been defined for the first time.

In the Copies group you can enter or select the amount of copies that needs to be printed.

By default CardExchange® PriceTag prints one copy.

If the card uses a global counter, in the Global counter group you can see the number

indicating the global counter number that will be used for the first card to be printed. For

each consecutive card the global counter will be incremented by one. The global counter

can be edited to change this number to another value. It is up to the user to decide whether

changing the default value is necessary.
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9 Using Data

Viewing and Managing data from a connected database is very important to having a

smooth production environment. CardExchange® PriceTag offers many ways to look up

data, enrich data, view data, etc.

In this section of the Help file we will go over all the functionality available like using

Filters, Updating your Database, etc.

9.1 Edit Data

The Database record window gives you direct access to the information stored in the

database. Provided that the CardExchange® PriceTag administrator has given you

permission to do so, you also can edit this data and add or remove records.
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The database record window is a dockable window which appears in the lower part of the

main window. By clicking on the bar with the text Database record, you can dock the

window to the upper part or to the sides. You can even turn it into an independent window

by dragging it to a position away from the edges of the main window. Clicking on the pin

will cause the window to minimize. Clicking on the cross will close the window.

On the left part of the docked window, there are five buttons for performing database

operations. On the right part, all Columns and values of the database records that apply to

the selected layout are displayed. If you select another record, the Edit database record will

load automatically the data associated with the selected record.

With the buttons, you can perform three types of database operations: Insert records,

Update records, and Delete records. The following sections will describe these actions one

by one.

9.1.1 Insert Database Records

A database record can be inserted in three steps:

· Click on the New button in the Database record window. Note that all fields will

be cleared in order to enable you to enter new data. The cursor will be positioned

automatically on the first field that can be edited. The buttons Insert and Cancel

will be enabled.
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· Enter the data you need into the empty fields.

· Click on the Insert button to load the data into the database, or on the Cancel

button if you do not want that.

While inserting a new record, all functions of the main window are disabled. These will be

enabled as soon as the Insert or Cancel button is clicked on. You can only insert a new

database records if the administrator has given you permission to do so and if no more

than one record has been selected in the name list.

9.1.2 Update Database Records

A database record can be updated in three steps:

· In the Records Pane, select the record you want to change.

· Click on the field you want to change and change it. The buttons Update and

Cancel will be enabled as soon as you start typing.

· Click on the Update button to load the data into the database, or on the Cancel

button if you do not want that.

While updating a new record, all functions of the main window are disabled. These will be

enabled as soon as the Update or Cancel button is clicked on. You can only update a

database records if the administrator has given you permission to do so and if no more

than one name has been selected in the name list.

Important! Updating records from connected CSV files is not supported.

9.1.3 Delete Database Records

A database record can be deleted in three steps:
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· In the Records Pane, select the record you want to remove from the database.

· Click on the Delete button in the Database record window.

· Say Yes to the question if you really want to delete the record. Say No if you do not

want that.

You can only delete database records if the administrator has given you permission to do

so and if no more than one record has been selected in the Data Record View. So you

cannot delete more than one record at the same time.

Important! Deleting records from connected MS Excel files and CSV files is not supported.

9.2 Using Filters

CardExchange® PriceTag offers you the possibility of filtering the data you need at the

database level so that only the relevant records are displayed. To do this, you have to

access the Filters section of the Home tab.

CardExchange® PriceTag has a Category filter which consists of a series of named filters

that the operator can activate or deactivate freely in order to filter the records shown in the

Records pane. 

The filter names are shown as buttons in the Categories pane of the main interface. By

clicking on a filter button or menu option, the filter in question is activated while all other

filters are deactivated. By clicking the button or menu option with the text (no filter) all

filters are deactivated. 
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9.2.1 Category Filters

Category filters are a series of named filters that the operator can activate or deactivate

freely in order to limit the number of records shown in the Records pane. 

The filter names are shown as buttons in the Categories pane of the main interface. By

clicking on the filter button with the text (no filter) all filters are deactivated. 

Adding Category filters starts by clicking on the Edit Categories button in the Filters

section of the home tab.
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The Window that opens manages the different created Category filters. This manager

offers you the ability to add or edit existing filters, rename or remove them, or change the

position in the Categories pane of the main interface by moving them up or down. By

selecting the 'Show no-filter button' the user will also have the option to view all records by

selecting the (no filter) button.

To add a new Category filter, simply click on the add button and the below window will be

displayed.
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Now, you can add a filter condition with the menu option Add conditions in the Edit menu

(you can also press the Insert key). A screen will be shown in which you can choose the

database column and functions and operators to use in your filter. In the example below

the column Category is used for filtering, without applying any database function. The

result is compared to the entered value using the is-equal-to operator.

After clicking OK, your window will look similar to the one shown below. 
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It is also possible to Add, Change or Delete your conditions. 

In fact, there is no limit on the number of conditions. Each condition will have its own field

in which values can be entered. When using multiple conditions, the following rules apply:

· If you leave a field empty, the condition will not be applied,

· If you enter values for more than one condition, only records are selected that meet

both conditions,

· If you type null or NULL and the operator is = or LIKE, only records are selected for

which the database column contains a null value,

· If you type null or NULL and the operator is <>, != or NOT LIKE, only records are

selected for which the database column contains a value,

· If you type null or NULL with another operator, no records are selected.
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Just select Add Condition, Change Condition or Delete Condition from the Edit menu.

You can also Delete All at once.

Please visit the "Tips and Tricks" section of this Help file for more information about

configuring filters.

With Category filters you can also define that a condition needs to be asked when the filter

is activated. In the screenshot you see that "[Category]=cheese". When we check "Ask for

condition when activated", a window will pop-up asking you to enter the condition for the

filter. After clicking OK, you will be prompted to enter a name for the filter.

When entering a name for the filter, just like with the card templates, also the filters can be

divided into groups. As in the screenshot above, everything before the backslash '\' is

considered to be the Group Name and is selectable in the drop down menu directly under

the Categories pane of the main interface. Everything behind the "\" is considered as the

name of the filter appearing as the button. Of course you can also directly enter only the

name for this defined filter.
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Click on OK to save the filter, the filter will be shown in the Categories pane of the main

interface. The defined Category Filters are also available via the drop down menu in the

Filters section of the Home tab.

Furthermore, the filter will be applied, showing you how the defined conditions actually

affect the data in the Records pane.

9.2.1.1 The SQL View

In a limited number of situations, the standard Category filter described in the previous

section does not offer the flexibility needed to define the desired conditions. In that case,

you have the possibility to choose the option Show SQL in the View menu.
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In this window, you can define your Category filter using the SQL of the connected

database. By default, you will see the SQL equivalent of the conditions defined in the

standard view of the filter, but you can change it to the way you want.

The SQL you enter will be stored in the internal database, but will be lost if you switch back

to the standard view. In that case, you will see the conditions as you defined them before

activating the Show SQL option.

9.2.1.2 Edit Category Filters

Existing Category filters can be Edited, Renamed and Removed by choosing Edit

Categories from the Filters section of the Home tab, the following window appears:
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In the list box, you see all Category filters that have been defined. With each Category

filter you can perform one of the following actions:

· Hide the filter (without removing it) by deselecting the check box that appears

before the filter name.

· Change its position in the Categories pane of the main interface by using the Move

up and Move down buttons.

· Add a new Category filter by clicking on the Add button

· Edit the conditions that make up the filter by clicking the Edit button.

· Change its name by clicking the Rename button and entering another name.

· Remove the filter by clicking the Remove button and confirming that action by

clicking Yes.

· Show or don't show the No filter button

9.2.2 Tips and Tricks

Upper and lower case

When filtering on a string variable, like the Product column in the database, you often do

not want to care about whether you enter upper or lowercase characters. You can

accomplish that by applying at both the left and the right hand side of the condition a
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function that converts the characters to lowercase (LOWER for SQLite LCase for Microsoft

Access).

The Like operator

It is also possible that you do not want to enter the complete name or that you do not

know how to spell a certain part of the name. By using the Like operator instead of the

equal sign, you can realize that, since Like allows for the use of wildcards. The most

important wildcards are the percent sign (%), that represents zero or more characters, and

the underscore (_), that represents a single character. Furthermore, you can give alternative

characters by putting them between square brackets ([]). Some examples of the use of

wildcards are:

· LOWER(“LASTNAME”) LIKE ‘s%’ selects all names that start with an s

· LOWER(“LASTNAME”) LIKE ‘cart%er’ selects both Carter and Cartner

· LOWER(“FIRSTNAME”) LIKE ‘Eri_’ selects all four character names that start wit Eri

· LOWER(“FIRSTNAME”) LIKE ‘Eri[ck]’ selects all persons called Eric or Erik

Numeric values

When you want to filter on numeric values, you have to take care that you use the correct

decimal separator (comma or point). In the advanced database filter, you have to follow

the configuration of you operating system. However, in the SQL view, you always have to

use a point.

Dates

Microsoft Access and SQLite store dates as date-time values. If you want to compare these

values, not only the date part, but also the time part has to match. If you only want to check

for equal date parts, you can achieve this by using the following conditions:

· Microsoft Access: Int([BirthDate]) = DateValue(’10-apr-1968’)

· SQLite: [BirthDate] >= ’10-apr-1968’ AND [BirthDate] < ’11-apr-1968’

In all cases, BirthDate is a date-time field and only those records will be selected for which

the date part is 10 April 1968.

Microsoft Access stores the date-time value as a floating point number. The part before the

decimal point represents the date part, whereas the decimals represent the time part. The

function Int removes the time part, setting it to 0:00:00 AM. The function DateValue always

results in a date-time value whose time part is 0:00:00 AM, so that the condition above

effectively compares only the date part of BirthDate.
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9.3 Record Lookup

The simplest way of adding the correct record details to the card is to use the Records pane

that is displayed at the left-hand side of the main window. You can use the scroll bar to

scroll through the list to find the correct record and then select it by clicking. The Records

pane may be sorted in various ways and is not necessarily alphabetical. You must take this

into account when searching for a record.

In the Records pane in the main interface of CardExchange® PriceTag you see all the

records presented that are available in your database. When you make a database

connection, in the Record look-up fields page you select the columns that are shown in the

Records pane. You can find everything about making database connections in the "Using

Databases" section of this Help file.

Record Sorting
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The Records pane is a so called data grid showing all your available database records

divided by columns. Sorting the records is just as simple as clicking on the column. 

Record Look Up

It is very simple to search for records inside the Records pane. Enter the text that you want

to search for in the text box directly above the columns. The text you enter always applies

to the first column displayed. If you want to look up records from other columns, for

example the Item Code column, you have to drag the column to the front. 

Loaded Record Information

In the footer of the Records pane, the total number of loaded records is shown.

You will notice that this method becomes less attractive if the list is very long and that you

need a more directed manner of finding the correct data. The following alternative find

methods are available:

· Finding records using the Find section in the Home tab,

· Finding names using the Keyboard

· Finding names using Filters

The first two methods will be explained in the following sections. For an explanation of

filters, please refer to the section Filters of this Help file.

9.3.1 Using Find

In the Find section of the home tab you can find the functionality Find. 



Using Data 155

© 2020 CardExchange Solutions, Inc.

If you select this option, you enter a dialog window in which you can enter a combination

of letters or digits to search on (only alphanumeric characters).

If you then click OK, the first element from records pane that contains the requested

combination is selected.
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If the first match is not the one you are looking for, you can search on the same

combination by selecting Find next in the Find section of the Home tab. You can repeat this

until you have found the correct record.

The advantage of searching in this way is that the text you enter does not need to be at the

start of an element in the Records pane. The search does not make a distinction between

upper- and lowercase characters.

With this Find function, all elements in the Records pane remain visible. Any restrictions to

the number of records that are displayed, which would normally apply as a result of what

you have entered in the text field, are overruled.

9.3.2 Using Keyboard

The find functions that have been discussed in the section Using Find are also available

from the keyboard. You can display the window Find by simultaneously pressing the

control key and the letter f. You can repeat the search as often as is required to find the

correct person by pressing the F3 function key.

9.3.3 Changing Sort Order

To facilitate the selection of records, especially when making multiple selections in order to

start a print batch, the order in which the records in the Records pane appear can be

changed. 

Record Sorting
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The Records pane is a so called data grid showing all your available database records

divided by columns. Sorting the records is just as simple as clicking on the column. 

9.3.4 Refresh Data

It is possible that you cannot find the intended record because it has only just been entered

into the database. The details of the record in question have already been entered into the

database, but CardExchange® PriceTag has not yet, as it were, seen it. You can solve this

problem by selecting the Refresh data option in the Find section (or by pressing the F5

function key). CardExchange® PriceTag will retrieve the list of records from the database

again.

Doing this ensures that the most recent data for the record concerned is displayed.
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10 Using Databases

CardExchange® PriceTag offers database connections. Database connections and the

stability of these connections has always been one the key factors for developing

connections.

Besides the variety of offered connections, all the major database connections are created

based on direct (native) connections. Therefore for all the major database systems, we have

their native connectors embedded. That will ensure 100% stable and secure connections.

The different types of database connections offered are shown below:

Supported Database Connections
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MS Excel (all formats), CSV, and TXT files, MS Access (all formats), SQLite

With CardExchange® PriceTag your data is securely processed with 128 bit encrypted

connections.

10.1 Database Connection

Adding a database connection starts in the Designer. Select the Data tab and in the

Connection group select New to start the Database Connection Wizard.

When the wizard opens you click Add to start making the connection.

Step 1

Enter a name for the database connection, select the correct database type, and select the

database file by typing the whole path with extension into the Database text box or click

on the  button to browse to the file location. You can also specify a password if using a

password protected Microsoft access or SQLite database.

Click Next to proceed. It is important to know that on the moment you click the Next

button, the wizard will check the connection with the file or database. If all is correct, the

wizard will proceed to the next page. If there is a problem then the database error will be

shown.
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Step 2

Select the check box 'Read data-items from this database', select the corresponding sheet

name in the case of Excel or table name in the case of Access or SQLite in the 'View name'

drop menu, and select the 'Primary Key' from the drop down menu. The Primary Key is the

unique identifier of the record in your database and must be unique. Click Next to proceed.
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Step 3

In the Main Interface of CardExchange® PriceTag you find the Records pane showing all

the records available in the database in a so called data grid. In this page of the wizard you

select the columns from the database that you want to show here. At least one database

column must be selected. Click Next to proceed with the next step of the Wizard.
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Step 4

In this page of the wizard you can set the rights to edit the connected database, or in this

case, the connected MS Excel file. Click on the check box 'Allow editing of the database

records' to enable this functionality. Separate from this selection you can set that the user

is allowed to add new records to the database, update existing records and delete records. 

In this case deleting is not available because deleting records in an MS Excel file is not

supported. 

In the Primary-key properties section you can select to enter the primary keys manually. If

you are not using numbers as primary keys, this check box needs to be selected but for each

new record, a unique primary key needs to be entered by the user. We advice to use

numbers and leave the check box as is by default, primary keys are generated by the

database. Normally real databases support this functionality itself, but because MS Excel is
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not a database, we have embedded a unique number generator so your primary keys are

taken care of by CardExchange® PriceTag. Now click Next to proceed.

Step 5

In this page you can set for each individual database column, whether is should be visible,

and if so whether is should be editable by the user in the Database record window of the

main interface. You can also create drop-down menus that can be selected from in the

Database record window, this is discussed further in the Drop Down Menu's section of this

help file.
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Step 6

In the last page of the wizard you can create storage items to automatically store

information back into the connected database at print time. This is discussed further in the

Storage Items section of this help file. Once done, click on Finish to complete the wizard.
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The last step is to give the Database connection a name, these settings are stored in a

Database definition file (.dtd file) and can be reused by multiple templates if required.

The default location is the Data Folder of CardExchange® PriceTag and we advice to store

your data in this location so it is all in one place.
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Now in a few simple steps you have created the connection to your MS Excel file and now

the columns are available in the Designer for adding to your design.



Using Databases 167

© 2020 CardExchange Solutions, Inc.

10.2 Drop Down Menu's

CardExchange® PriceTag offers great functionality to add drop down menus to your Data

record Window. Using drop down menus limits user error when entering new or updating

existing data.

The creation of drop down menus is a part of the Database Connection Wizard.
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When adding a database, on the specify data columns page of the wizard, you see a tab

called Editor selection. 

The Editor selection contains the option of creating a menu based on fixed values

indicated with a red rectangle. 

To create a drop down menu with fixed values, you first select the column from Columns

Explorer on the left side and select the Drop-down menu with fixed values option from

the Editor selection tab. The text box becomes available and you can simply add items for

the drop down menu by entering them as text as shown in the screenshot above.

It is also possible to import a CSV file containing the items for the drop down menu. To do

so, click on the Import button and browse to the file.
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And click on Open to select the file for Import.
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When the file is imported, the information of the file is shown in the text box indicated with

the red rectangle. If the file contains a header, make sure the Skip first line is selected to

make sure that it is not going to be a part of the drop down menu items, and select the

Delimiter used for the the file, in this case a comma.

10.3 Storage Items

If you want to store data into the connected database, you need to define Storage Items.

Storage Items contain the information of the column name in which you want to save your

information like counters or print dates. This Storage Item will be presented in the
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Storage Items section of the Data tab in the Explorer Menu of the Designer and where they

will be connected to the correct Object Type. See Objects and Standard Object Types

sections of this Help file for more information.

For the connected database you can define storage items. Just click on the database name

on the left side to select and click on Add to define a storage item. You can add unlimited

storage items for the connected database.

Storage Items are configured in the last page of the Database Connection Wizard. For

more information about the Database Connection Wizard and examples of how to make

Database connections, please see the Databases section of this Help file. In this section we

will explain all the available functionality of the Storage Items section of the wizard.
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The Storage Items section of the wizard is divided into three different sections which are

the Storage items section on the left side showing the connected database and the created

storage items, The Storage-item properties group, and the Storage-item usage group.

The Storage-item properties

This section, indicated with the red rectangle, shows four important properties:

Storage Item

Property

Description

Item name Enter a name for the storage item like Print Date, for example.

Table Name Select the table from the database where you are storing the data

Primary Key Select the Primary Key from the selected database

Column Name Select the column name from the selected table
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The Storage-item usage

This section, indicated with the red rectangle, shows three options.  You can use these

options under the General tab to specify the usage of the storage-item so CardExchange®

PriceTag knows that it will handle a counter instead of normal columns for example. 

The default option is Store data after printing a card, this will store the defined value after

the card has printed.

The option Store button-triggered plug-in output is and advanced option and should not

be used.

You can also set the option Use as print counter. This will increase the value in the column

every time you print a record.

When you click on Finish, you will return to the Designer window.
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In the Designer Interface you click on the Data tab of the Explorer Menu and now you see

the Storage Item tab. Click on this tab and all the created Storage Items will be shown as

indicated in the area with the red rectangle. The bold name indicates the connected

database and the indent are the created storage items.

Now make sure that you have the Properties window open and make sure the Content tab

is selected. Select one of the Storage Items, in this example we selected the PrintDate item

from the Excel spreadsheet.
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The Standard option offers you the possibility to connect to any object available and works

exactly the same as explained in the section Standard Object Types of this Help file. 

If we wanted to store the date that the card was printed, we could select Print date from

the Standard Object Type drop down menu. We set the Format option to Date/time and

enter the 'd' to make sure we store the short date only and not the time and you are good

to go!
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11 Authorizations

User Authorizations are created and setup for a reason, and that reason is security.

CardExchange® PriceTag offers advanced user authorizations with login functionality. 

In order to create more control for the Administrators of CardExchange® PriceTag, we

offer the ability to create user authorization levels. This helps limit user infractions and

protect areas within CardExchange® PriceTag that the common user should not be

utilizing. This high level security allows you to protect the software connections and

functionality from user errors.

To enable the User Authorizations within CardExchange® PriceTag, first select Enable

logins feature from the Configuration tab as indicated with the red rectangle.

When selecting a dialog will prompt for confirmation:

When you confirm this, the User Account-setup wizard will start.
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In the section Create User Authorization we will explain how to create the users. To disable

the User Authorizations, uncheck the Enable logins feature check box, a dialog will pop

up:

And select Yes to disable the functionality.
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11.1 Create User Authorizations

In this page of the wizard you can create new or edit existing users of the system. On the

explorer on the left side you can find all the available users, on the right side you can find

all the user information.

By default, there will be two users already created. PCPAdmin that will have access to all

options within CardExchange® PriceTag, and PCPUser that will not have access to the

configuration options.

You can add to these users and edit them as required. When you click on Add, to create a

new user, you will need to provide a User name, this is the name used to login to

CardExchange® PriceTag, enter a Full name of the user, and enter a Password and

Confirm the password.
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The default user name for the Administrator account is PCPAdmin and the Password is

also PCPAdmin! For the User the password and user name are both PCPUser. Passwords

are case sensitive! 

Important! The Administrator has always access to all defined users!

In the area indicated with the red rectangle, you find three special options. If you want the

user to generate their own password, just check the box User must change password at

next login. This can be handy if you have a lot of different users to create but you do not

want to send out all these different passwords. When you select this option, you can simply

use a standard password which first needs to be changed before the user can login to the

system.

Disabling the user is also a handy option. By checking this box, the user cannot login to the

system anymore but is not removed from the system. If later the user needs to get access to

the system again, simply uncheck the User is disabled box and access is granted again. 

The last option is currently not used.
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When you have created or edited all your users of the system, you can proceed with the

Authorizations management on the next and final page by clicking Next.

Authorizations management



Authorizations 181

© 2020 CardExchange Solutions, Inc.

In this last page of the wizard can assign and create the profiles for each user. In the

explorer on the left side you can see all the created users.

On the right side, you see three main sections dividing the available CardExchange®

PriceTag functionality. When you click on the expand  button next to each section, the

corresponding functionality will be shown. 

Card templates shows all of the available templates, for different users you can set that

only certain templates are visible to them.

The Filters section where again you can make only certain categories visible to the selected

user.

And the Actions section controls what actions can be carried out by the user, for example

changing printer options, printing a card etc...
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When you have defined all the users, and assigned the functionality allowed for each user,

you can click on Finish to close this wizard.

11.2 Users Login Access

When User Authorizations is enabled, every time CardExchange® PriceTag starts, the user

will have to login. If it is a new account, it can be that the Administrator has set the option

to change the password at first login. When that is the case, the the standard login window

will appear as show below:

When the user enters his User name and password, and the Administrator has set the option

to change the password at first login, the message as shown below will appear:

To confirm this action you have to click OK and the Change Password window will appear:
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Enter a new password and confirm the new password and click on OK. If the User name and

Password match, CardExchange® PriceTag will load.

When CardExchange® PriceTag is loaded, you can directly see that things have changed.

First of all, the ribbon has only the Home and Assist tabs available. 

When you are an Administrator and you need to do some maintenance on the users

computer, just simply select Logout and enter your Administrator User name and

Password to make changes.
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12 Assist

With the release of CardExchange® PriceTag we bring a unique innovation to your desktop

by offering everything that you need to produce cards in a fast and secure way at hand

under the Assist tab.

Help file, Activation, Registration, Product details etc... it is all available in this section of

your CardExchange® PriceTag product. When you select the Assist tab, you will directly see

an Outlook style interface showing on the left the available news items and on the right the

content of this news item.

CardExchange® PriceTag uses this section to keep you informed about new updates and

release plans so you will always be able to run the latest version. But also the reseller who

has sold the product to you will keep you informed about news and offers etc...

Take a look at the separate subjects in this section of the Help file and see how this is going

to benefit you!

12.1 Help

Have access to the latest online help file directly by clicking on the Help button.
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Our online Help files are always up to date and contain examples for all available

functionality. Of course you need to have an online internet connection. 

When no internet connection is available, the internal Help file will be loaded:

12.2 Activation Window

How you activate your new CardExchange® PriceTag license is covered in the section

Activation and Registration. 

12.3 Register License

When CardExchange® PriceTag is activated, the registration data will already have been

entered during this process. When you have registered your software, you can always

update your registration information. 

Click on the Register License button and CardExchange® PriceTag License Activation

Wizard will start.

Your existing registration data will be displayed in the window, you can change the

information you want to change and proceed to the Next page when done.
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If you would like to be contacted, just select how and when, you can also change your

subscription to our newsletter.
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Click Next to proceed to the Final page of the Registration process.
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Then click Finish to complete the Registration process.

12.4 About CardExchange®

Sometimes when you need support, you will be asked which version you are running of

CardExchange® PriceTag. All this type of information can be found in the About

CardExchange® PriceTag section. 
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Just click on the button indicated above, and the window below will be presented.

In this window you can find the version you are running. This can be important to see if you

are running the latest version with regards to solved bugs.

You also can see your serial number which enables us to confirm your activation code, if

needed. It also shows the Machine ID, the digital fingerprint of your computer for your

CardExchange® PriceTag license.

There are also options to check for updates, as well as an option to display some

information from your system regarding hardware etc...

12.5 Contact Information

Clicking on the CardExchange® PriceTag logo will take you directly to the CardExchange®

PriceTag website where you can find details on the products, consumables etc... as well as

contact information for your region.
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Together with all the other functionality offered in our Assist section, we strive to offer high

quality with high service without limitations.
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